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Preface 
 

CAD stands for Computer Aided Drafting. Like all other technical fields, in drafting 

computer have brought revolution. CAD has not only reduced the time spent for drafting to a 

fraction, of that the same produced by hand drawings, but also any revisions in the drawing 

can be done quickly without having to redraw everything. Moreover, different views, such as 

front view, side views etc. can be easily created from the drawing. To use CAD software 

efficiently, it is necessary to know all drafting tools to have a good control over the work. 

This lab manual intends to guide the students to know the fundamental tools to create, modify 

and manage documentation effectively through a skillful way. 

 

 

 

Debasish Sen 

Department of Civil Engineering 

Ahsanullah University of Science and Technology 

 

 

 

 

 

 

 

 

 

 

 



Department of Civil Engineering  
AUST 

                                                             

 
CE 102: Computer Aided Drafting  
 

 

Index 
Computer Aided Drafting (CAD)....................................................................................................... 1 

2D User Interface (AutoCAD 2007) .................................................................................................. 1 

Frequently Asked Questions .............................................................................................................. 2 

Coordinate System ............................................................................................................................ 5 

Object Selection Method ................................................................................................................... 5 

Zoom ................................................................................................................................................ 5 

Status Bar .......................................................................................................................................... 6 

1. ORTHO ................................................................................................................................. 6 

2. OSNAP.................................................................................................................................. 6 

3. DYN ...................................................................................................................................... 7 

4. LWT ...................................................................................................................................... 7 

Draw Toolbar .................................................................................................................................... 7 

1. Line ....................................................................................................................................... 7 

2. Rectangle ............................................................................................................................... 8 

3. Circle ..................................................................................................................................... 8 

4. Arc ........................................................................................................................................ 8 

5. Donut .................................................................................................................................... 9 

6. Polygon ............................................................................................................................... 10 

7. Ellipse ................................................................................................................................. 10 

8. Region ................................................................................................................................. 11 

9. Hatch ................................................................................................................................... 11 

10.   Text ..................................................................................................................................... 13 

11.   Block ................................................................................................................................... 14 

Modify Toolbar ............................................................................................................................... 15 

1. Offset .................................................................................................................................. 15 

2. Copy .................................................................................................................................... 15 

3. Move ................................................................................................................................... 15 

4. Rotate .................................................................................................................................. 16 

5. Mirror .................................................................................................................................. 16 

6. Extend ................................................................................................................................. 16 



Department of Civil Engineering  
AUST 

                                                             

 
CE 102: Computer Aided Drafting  
 

7. Trim .................................................................................................................................... 16 

8. Array ................................................................................................................................... 17 

9. Scale .................................................................................................................................... 17 

10.   Stretch.................................................................................................................................. 18 

11.   Fillet .................................................................................................................................... 18 

13.   Explode ................................................................................................................................ 18 

14.   Match properties .................................................................................................................. 18 

Grips: Important Modification Tool ................................................................................................. 19 

Format Tab ...................................................................................................................................... 20 

1. Unit ..................................................................................................................................... 20 

2. Text Style ............................................................................................................................ 20 

3. Dimension Style .................................................................................................................. 20 

4. Layer ................................................................................................................................... 21 

Dimension Toolbar .......................................................................................................................... 22 

1. Linear .................................................................................................................................. 22 

2. Aligned ................................................................................................................................ 23 

3. Continue .............................................................................................................................. 23 

4. Angle ................................................................................................................................... 23 

5. Radius ................................................................................................................................. 23 

6. Diameter .............................................................................................................................. 23 

7. Quick Leader ....................................................................................................................... 24 

8. Dimension Text Edit ............................................................................................................ 24 

9. Dimension Edit .................................................................................................................... 24 

Miscellaneous commands ................................................................................................................ 25 

1. Polyline ............................................................................................................................... 25 

2. Multiline .............................................................................................................................. 25 

3. Divide .................................................................................................................................. 25 

4. Measure ............................................................................................................................... 25 

5. Align ................................................................................................................................... 26 

6. Group .................................................................................................................................. 28 

7. Oops .................................................................................................................................... 28 

8. Wipeout ............................................................................................................................... 28 

Important Control Keys ................................................................................................................... 28 



Department of Civil Engineering  
AUST 

                                                             

 
CE 102: Computer Aided Drafting  
 

Tips for Working Faster in AutoCAD .............................................................................................. 29 

Assignments .................................................................................................................................... 30 



Department of Civil Engineering  
AUST 

                                                             

 

CE 102: Computer Aided Drafting Page 1 
 

Computer Aided Drafting (CAD)  

 The use of computer technology for the process of design documentation (i.e. 

drafting). 

 CAD may be used to draft in 2D or 3D space. 

2D User Interface (AutoCAD 2007) 

 

 

 

 

 

 

 

 

 

Drop Down Menu 
Standard Tool Bar Style Tool Bar 

Properties Tool Bar Layer Tool Bar 

Cursor 

Modify Tool Bar 

 

Draw Tool Bar 

 

Axis 

Command Bar 

Coordinates Status Bar 
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Drop-Down Menu: All options of AutoCAD can be accessed from this 

menu. 

Standard Tool Bar: Shows copy, cut, paste, save, zoom icons. 

Style Tool Bar: Shows current text style, dimension style, table style.  

Layer Tool Bar: Shows current layer name. 

Properties Tool Bar: Shows color, line type, line weight. 

Draw Tool Bar: Shows line, rectangle, circle icons. 

Modify Tool Bar: Shows modification icons.  

Command Line: Shows activated command. 

 

Frequently Asked Questions 

 

How to bring a toolbar on user interface? 

 Right click on any toolbar (i.e. Draw) 

 Select required toolbar (i.e. Dimension) from list (Shown in the 

figure)  

 Set the position of the toolbar (click at the double line border and 

drag it) 

 

How to Change workspace from 3D to 2D or vice versa? 

 Press “Tools” 

 Select “Workplaces” 

 Select “ 3D modeling” or “AutoCAD classic” 

 

 

 

 

 

 

List of all tool bar 
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How to start and terminate commands in AutoCAD? 

 Three ways to start a command (i.e. Line) 

1. From Drop Down Menu ( Draw > Line) 

2. From Command line with short key (Type “ l ” in the command line and press 

“Enter”) 

3. From Toolbar (Click on the line command icon on the draw toll bar) 

 Press “Esc” button on keyboard to terminate any command. 

 

How to start and complete a drawing? 

 Set drawing unit (Format > Unit) 

 Create  text styles (Format > Text Style) 

 Create dimension style (Format > Dimension Style) 

 Create new layers (Format > Layer) 

 Draw and modify objects (Use Draw and Modify toolbar or menu) 

 Provide dimensions ( Use dimension toolbar or menu) 

 Write texts (Use draw toolbar or menu) 

 

How to save a file? 

 Click “File” on Drop Down Menu bar 

 Click “Save as” 

 Select “Drive” to save 

 Rename file name only (keep .dwg as extension) 

 Press “Save” 

 

Or 

 

 Press “Ctrl” + S 

 Select “Drive” to save 

 Rename file name only (keep .dwg as extension) 

 Press “Save” 
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How to plot a file? 

  Press “Ctrl” + P 

 Select printer name / DWG to PDF.pc3 (Use “Printer name” to print and DWG to 

PDF to publish as pdf) 

 Select paper size  

 Check “Fit to paper” 

 Check “Center the Plot” 

 Press more option (if necessary)  

 Select Plot style table (None is ok. Select Monocrome.ctb for black and white 

print) 

 Select quality 

 Select drawing orientation 

 Press “Preview” 

 Press “Plot” 

 

Why one may use polyline?  

        Polylines have some unique qualities that make them very useful: 

 Polylines drawn under one single command can be selected by single click. 

 They can have width (constant or varying) 

 They can consist of arcs and lines 

 They can be edited 

 They can be joined together. 

 They can be exploded into individual segments 

 Especially useful for 3D drawing 

 

How to cancel the last command? 

  Press “undo” button on standard toolbar  

 Or 

  Press “Ctrl” + “Z” 
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Coordinate System 

 World Coordinate System (WCS): A fixed coordinate system. Measures coordinate 

from fixed X-Y axis. 

 User Coordinate System (UCS): A movable coordinate system. Measures coordinate 

from clicked point. UCS makes it easier to draw a particular object. 

 

Object Selection Method 

 
 

              By window                      By Crossing Window 

 

1. By pickbox 

 Click object or objects to select.  

2. By window (Left to Right) 

 All objects which lie entirely within the window will be selected. 

3. By crossing window (Right to Left) 

 Objects are selected which lie entirely within the window and those which 

cross the window border. 

N.B.: Use “Shift” + “Left Mouse Button” to deselect an object. 

 

Zoom (Standard Tool Bar) (z) 

1. Pan real time: Move display.  

2. Zoom real time: Increase or decrease display size. (Use mouse scroll as alternative) 

3. Zoom window: Enlarge the part of the drawing 

4. Zoom previous: Returns to the last Zoom view. 

 

       N.B.: To bring all drawings on screen use zoom all (Z A ). 

Start pointStart point

End pointEnd point
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Status Bar 

 

1. ORTHO (Ortho mode)  

 Click on “ORTHO” button on Status bar or Press F8 

 Enforces to draw horizontal or vertical lines only 

 

2. OSNAP (Object snap) 

 Click on “OSNAP” button on Status bar or Press F3 

 Right click on “OSNAP” button on Status bar 

 Press “Setting” 

 Check desired object snap options 

 Press “ok” 

 Helps to snap (grip) different points during drafting 

 

Figure: Available snap options. 
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3. DYN (Dynamic Input) 

 Click on “DYN” button on Status bar or Press F12 

 Shows command line with cursor during execution of any command 

 

4. LWT (Line weight) 

 Click on “LWT” button on Status bar 

 Shows line thickness 

 

Draw Toolbar  

 

1. Line (l) 

 

a. By picking two points 

 Specify first point (click at any point) 

 Specify next point (click at any point) 

                                      Or 

b. By direct distance entry 

 Specify first point (click at any point). 

 Input length (type length of the line) 

 Press “Tab” on the keyboard  

 Input angle (type angle with the X axis) 

 Press enter(  )  on the keyboard 

 

Horizontal or vertical line  

 Specify first point (click at any point) 

 Press “ORTHO” in status bar or press F8 on keyboard. 

 Input length (type length of the line) [Keep the cursor appropriately] 

 Press enter(  )  on the keyboard 
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2. Rectangle (rec) 
 

a. By picking two points 

 Specify first corner point (click at any point) 

 Specify other corner point (click at any point) 

                                   Or 

b. By direct distance entry 

 Specify first corner point (click at any point) 

 Input length along X (type length of the rectangle) 

 Press “Tab” on keyboard  

 Input width along Y  (type width of the rectangle) 

 Press enter(  )  on the keyboard 

 

3. Circle (c) 

 Specify center point (click at any point) 

 Input radius of the circle (type radius of the circle) 

 Press enter(  )  on the keyboard 

                                      Or 

 Specify center point (click at any point) 

 Type d  

 Press enter(  )  on the keyboard 

 Input diameter of the circle (type diameter of the circle)  

 Press enter(  )  on the keyboard 

 

4. Arc (a) 

To draw an arc three points on the arc are necessary. The choice of these points depends 

on the user or availability of defined points. AutoCAD by default draw arc anticlockwise. 

So select start and end points properly to get the desired arc shape. 

 
Figure: Start point and end point of arc 

 

 

Start point

End point

End point

Start point
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Available options Steps 

Center, Start, End 

 Type c 

 Press enter(  )  on the keyboard 

 Specify center point of the arc (Click at the center 

point of the desired arc) 

 Specify start point of the arc (Click at the start point of 

the desired arc) 

 Specify end point of the arc (Click at the end point of 

the desired arc) 

 

Start, center, end 

 

 Specify start point of the arc (Click at the start point of 

the desired arc) 

 Type c 

 Press enter(  )  on the keyboard 

 Specify center point of the arc (Click at the center 

point of the desired arc) 

 Specify end point of the arc (Click at the end point of 

the desired arc) 

Start, Center, Angle 

 

 Specify start point of the arc (Click at the start point of 

the desired arc) 

 Type c 

 Press enter(  )  on the keyboard 

 Specify center point of the arc (Click at the center 

point of the desired arc) 

 Input angle (Angle of end point with X axis at center) 

Start, End, Radius 

 

 Specify start point of the arc (Click at the start point of 

the desired arc) 

 Type e 

 Press enter(  )  on the keyboard 

 Specify end point of the arc (Click at the center point 

of the desired arc) 

 Type r 

 Press enter(  )  on the keyboard 

 Input radius. (type radius of the desired arc) 

Special note: 

 For simplicity use polyline to draw arc. 

 

5. Donut (do) 

 Input inside diameter (generally zero (0)) 

 Press enter(  )  on the keyboard 

 Input outside diameter ( choose a value based on your drawing )  

 Press enter(  )  on the keyboard 
 Specify center of donut (click at points where donuts are necessary) 
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6. Polygon (pol) 

 Input number of sides 

 Specify center of polygon (click at point) 

 Select an option 

 Inscribed in circle 

 Circumscribed about circle 

 Input radius of circle 

 

 
               Inscribed in circle                                Circumscribed about circle 

 

 

7. Ellipse (el) 

 Specify first point of major axis (click at point) 

 Specify endpoint of major axis (click at point) 

 Input distance from the midpoint of the first axis to the endpoint of the minor 

axis 

 

 
 

 

 

 

Major axis

First point

M
in

o
r ax

is

D
is

ta
n

ce

End point



Department of Civil Engineering  
AUST 

                                                             

 

CE 102: Computer Aided Drafting Page 11 
 

8. Region (reg) 

 Select objects ( lines intersect at end points are appropriate objects) 

 Press enter(  )  on the keyboard 

 

Choice of objects 

 
Appropriate 

 
Not appropriate 

 

9. Hatch (h) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                     Figure: Hatch Properties Manager                                                           
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 Use predefined type 

 Choose the desired pattern ( i.e. concrete, brick etc) 

 Choose angle (Change the orientation of the hatch lines but default is 

recommended)  

 Input scale value (Large value lightens the hatch and small value densifies 

hatch) 

 Choose appropriate boundary selection option 

 Add pick points: Click at any point in a closed boundary (does not 

work if any gap on the boundary) 

 Add select objects: Select objects (objects may or may not create 

closed boundary 

 Press enter(  )  on the keyboard 

 Choose option 

 Check “ Associative” option to allow modification of hatch shape with 

the boundary shape 

 Check “Create separate hatches” option to create separate hatches in 

case of multiple boundary selection 

 Press “Preview” 

 Observe hatch created 

 Press enter(  )  on the keyboard 

 If obtain desired hatch press “ok” or Change parameters and repeat from 

preview. 

Angle and Scale Type 

Angle            0                     0                    0 

            
Angle           45                   90                 135 

 
Concrete         Brick            Sand 

 
Brick          Grass            Gravel 

 

         
Scale             1                    5                   10 
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Choice of boundary selection  

 
    “Add pick points” 

 Or  “Add select objects” 

 
“Add select objects” 

 

Special Notes:  

 One can choose more than one boundary at a time to create hatch (use separate 

option for convenience). 

 One can modify any hatch by double clicking. 

 Choose proper island style [if necessary]. Any enclosed area inside the hatch 

boundary is island. 

 

 
Island style :                  Normal                          Outer                          Ignore 

 

 

10.  Text (t) 

 Draw small window 

 Select text style and font (if necessary) 

 Choose text height 

 Write on the shaded box 

 Press enter(  )  on the keyboard to go next line (if necessary) 
 Press “ok” 

Hatch boundary
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Special Notes:  

 One can modify text by double clicking. 

 One can underline a sentence or make a word bold etc. 

 One can insert symbol ( use @ icon) 

 One can insert fraction or subscript or superscript. 

 Command Output 

Superscript 

 Type   X2^ 

 Select  2^ 

 Press “Stack ( 
𝑎

𝑏
 )” icon 

X
2 

Subscript 

 Type    X^2 

 Select   ^2 

 Press “Stack ( 
𝑎

𝑏
 )” icon 

X2 

Fraction 

 Type   X/Y 

 Select X/Y 

 Press “Stack ( 
𝑎

𝑏
 )” icon 

𝑋

𝑌
 

 

 

11. Block  

 
Figure : A dining table as block 

a. Insert block (i) 

 Browse (C:\Program Files \AutoCAD 2007 \Sample\Design center\ House 

designer) 

 Check explode 

 Press “ok” 

 Specify insertion point for block (click at any point of window) 

 Zoom all to see blocks 
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b. Make Block (b) 

 Draw an object  

 Define a name to the block 

 Input base point (Press pick point and click at any  point closer to the object) 

 Select object ( select the desired object to make block) 

 Press enter(  )  on the keyboard 

 Check “Convert to Block” 

 Choose appropriate block unit 

 Press “ok” 

 Keep the file for further use as block 

 

Modify Toolbar 

 

1. Offset (o) 

 Input offset distance (perpendicular distance between parallel lines) 

 Press enter(  )  on the keyboard 

 Select object ( only one line can be selected) 

 Specify point on side to offset ( select any side of the line) 

 

 

2. Copy (co or cp) 

 Select object or objects 

 Press enter(  )  on the keyboard 

 Specify the base point 

 Specify second point or input distance (horizontal or vertical or inclined) 

 

3. Move (m) 

 Select object or objects 

 Press enter(  )  on the keyboard 

 Specify the base point 

 Specify second point or input distance (horizontal or vertical or inclined) 
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4. Rotate (ro) 

AutoCAD by default considers anticlockwise rotation as positive. So to rotate clockwise 

one should assign negative angle. 

 Select object or objects 

 Press enter(  )  on the keyboard 

 Specify the base point 

 Input angle ( angle with X axis) 

 

5. Mirror (mi) 

 Select object or objects 

 Press enter(  )  on the keyboard 

 Specify first point of the mirror line 

 Specify second point of the mirror line 

 Press enter(  )  on the keyboard 

 

6. Extend (ex) 

 Select line or lines as boundary edge ( Right click mouse to select all lines as 

boundary edges and skip next step) 

 Press enter(  )  on the keyboard 

 Select end of the object or objects closer to boundary edge to extend  

 

 

7. Trim (tr) 

 Select line or lines as cutting edge ( Right click mouse to select all lines as 

cutting edges and skip next step) 

 Press enter(  )  on the keyboard 

 Select object or objects to trim  

 

Special Notes: 

 Hold “Shift” key to alter trim and extend command. 
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8. Array (ar) 

a. Rectangular array 

 Input number of row and column 

 Input row and column offset (Offset means c/c distance of rows or columns ) 

 Input angle of array (if necessary) ( indicates the angle of row with positive x 

axis) 

 Select object  

 Press enter(  )  on the keyboard 

 Press “Preview” 

 Observe the array created 

 If obtain desired array press “accept” otherwise press “Modify” and repeat 

steps 
 

b. Polar array 

 Specify center point  

 Choose appropriate method of array (i.e. choose any two parameter from total 

no. of item, angle to fill and angle between item) 

 Input parameter values 

 Total no. of items: Input number of items to be considered as array 

element 

 Angle to fill: Input angle to be filled up by the array elements 

 Angle between items: Input angle between array elements at center of 

the circle. 

 Check/uncheck rotate items as copied (allow/disallow the rotation of array 

elements) 

 Select object  

 Press enter(  )  on the keyboard 

 Press “Preview” 

 Observe the array created 

 If obtain desired array press “accept” otherwise press “Modify” and repeat 

steps 

 

9. Scale (sc) 

 Select object or objects 

 Press enter(  )  on the keyboard 

 Specify the base point  

 Type scale factor (Greater than 1 to enlarge and less than 1 to shrink 

proportionally) 

 Press enter(  )  on the keyboard 
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10.   Stretch (s) 

 Select object or objects (select only by crossing window) 

 Press enter(  )  on the keyboard 

 Specify the base point  

 Type distance (the distance of the base point movement) 

 Press enter(  )  on the keyboard 

 

11.  Fillet (f) 

 Type r ( to input radius first)   

 Press enter(  )  on the keyboard 

 Input radius 

 Press enter(  )  on the keyboard 

 Select the first object (line) 

 Select the second object (line) 

       Special Notes: Use Fillet + “Shift” key to get 

sharp corner. 

 

12. Chamfer (cha) 

 Type d ( to input distance first)  

 Press enter(  )  on the keyboard 

 Input first chamfer distance 

 Press enter(  )  on the keyboard 

 Input second chamfer distance 

 Press enter(  )  on the keyboard 

 Select the first object (line) 

 Select the second object (line) 

 

13.   Explode (x) 

 Select object 

 Press enter(  )  on the keyboard 

 

14.  Match properties (ma) 

 Select source object 

 Select destination object or objects 

                                                                                          
 

 

Radius

Chamfer distance

C
h

am
fe

r 
d

is
ta

n
ce
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Grips: Important Modification Tool 

 Grips are those dots appear at the endpoint and midpoint of a line after selection. 

 

Unselected 

Grip 

(Blue) 

 
 

(Just after selection) 

Hover Grip 

(Green) 

  
(Just after keeping the cursor on the grip) 

Selected 

/Hot Grip 

(Red) 

  
(Just after clicking on the grip) 

 

 

Action Command appears Result 

Click on any end point Stretch Activate Stretch command 

Click on the midpoint Move Activate Move command 

Press “Ctrl” + click on the 

midpoint 

(Hold “Ctrl” until make one copy) 

Copy Activate Copy command 

Click on any point then press 

“Enter” 
- 

Change from Stretch to Move, 

Rotate, Scale and Mirror 

Press “Shift” + click on any point 

 
- 

Allow to select multiple grips  
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Format Tab 

 

1. Unit  

 Choose appropriate unit system as drawing unit 

 Choose proper precision 

 Choose insertion scale (Unit of any value inserted without unit (i.e. ft/inch/mm 

etc.)) 

 

2. Text Style  

 Press “New” 

 Define style name 

 Specify font name (i.e. Times New Roman) 

 Choose a height  

 Press “Apply” 

 Press “Close” 

 

3. Dimension Style  

 Press “New” 

 Define new style name 

 Press “continue” 

 Press “ Symbol and arrows” tab 

 Select first and second arrow head 

 Press “ Text” tab 

 Choose text style 

 Press “ Fit” tab 

 Set use overall scale of ( Large value enlarges dimension text) 

 Press “ Primary Unit” tab 

 Choose unit format ( Generally same as Drawing Unit ) 

 Choose proper precisions (Generally same as Drawing Unit ) 

 Zero suppression ( Don’t show 0Ω ƻǊ лέ ŜǘŎύ 

 Suffix  ( if necessary to show something as suffix of the dimension text) 

 Prefix ( if necessary to show something as prefix of the dimension text) 

 Scale factor (if necessary to multiply dimensions with any value) 

 Press “ ok”  

 Select dimension style created 

 Press “Set Current” 

 Press “Close” 
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4. Layer  

 Press “New layer” 

 Double click and rename “Layer Name” 

 Click and choose color 

 Click and choose line weight 

 Click on line type 

 If new line type is needed press “Load” 

 Choose a line type 

 Press “ok” 

 Select the loaded line type and press “ok” 

 Repeat steps to create more layers 

 Press “ok” 

 

       Special Notes: 

 New objects are drawn automatically with current layer. 

 One can change objects layer manually from layer toolbar. 

 When a layer is on, it is visible and available for plotting. When a layer is off, it 

is invisible and not plotted, even if Plot is on.  

 If plotting is off for a layer, the objects on that layer are still displayed but will 

not be plotted. 

 Objects on a locked layer cannot be modified. 

 Objects on frozen layers are not displayed, plotted or regenerated. 

 If dashed lines are not visible then change line type scale  

 Type “ ltscale ” 

 Press enter(  )  on the keyboard 

 Input scale factor ( larger value make the gap visible) 
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Dimension Toolbar 

 

1. Linear  

 Click at the first extension line origin 

 Click at the second extension line origin 

 Click to fix dimension line location 

 

 
 

 

 

Dimension Line

E
x

te
n
si

o
n

L
in

e

E
x

te
n
si

o
n

L
in

e

Extension

Line origin

Extension

Line origin
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2. Aligned  

 Click at first extension line origin 

 Click at second extension line origin 

 Click to fix dimension line location 

 

3. Continue  

 Continue from last dimension 

 Click at only second extension line origin and so on                           

             Or 

 Continue from any dimension 

 Type s (to select a dimension) 

 Press enter(  )  on the keyboard 

 Select desired dimension 

 Click at only second extension line origin and so on 

 

4. Angle  

 Select the first line  

 Select the second line  

 Click to fix dimension line (arc) location 

 

 

5. Radius  

 Select circle  

 Click to fix dimension line (leader) location 

 

6. Diameter  

 Select circle  

 Click to fix dimension line (leader) location 
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7. Quick Leader  

 Click at first leader point 

 Click at next point of leader 

 Click at next point of leader (if necessary) 

 Input text width (default is ok) 

 Press enter(  )  on the keyboard 

 Type first line of annotation text 

 Press enter(  )  on the keyboard 

 Type second line of annotation text (if necessary, otherwise skip) 

 Press enter(  )  on the keyboard 

 

8. Dimension Text Edit  

  Select dimension  

 Click at desired location to set dimension text 

 

9. Dimension Edit  

 Press “New” 

 Select and delete “ 0έ ” 

 Type desired dimension with unit or text 

 Press “ok” 

 Select dimension to be changed 

 Press enter(  )  on the keyboard 

                                          Or  

 Type “ddedit” 

 Press enter(  )  on the keyboard 

 Select existing dimension and delete 

 Type desired dimension with unit or text 

 Press “ok” 
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Miscellaneous commands 

 

1. Polyline (pl) 

 Specify first point (click at any point) 

 Specify next point (click at any point) 

                                      or 

 Specify first point (click at any point). 

 Input length (type length of the line) 

 Press “Tab” on the keyboard  

 Input angle (type angle with the X axis) 

 Press enter(  )  on the keyboard 

        Special note 

 You can draw arc, line with certain width using polyline. For this just look at the 

command line. 

 

2. Multiline (ml) 

 Press “s” to input parallel line distance 

 Press enter(  )  on the keyboard 

 Press “j” to select zero (centerline)/top/bottom length 

 Press “z” or “t” or “b” 

 Press enter(  )  on the keyboard 

 Specify first point (click at any point) 

 Input length (type length of the line) 

 

3. Divide (div) [Draw > Point > Divide ] 

 Select object to divide 

 Input number of  segments 

 Press enter(  )  on the keyboard 

Special notes: 

 To see the points on the line, create point style 

 Format > Point style > Choose point icon > ok 

 

4. Measure (me) [Draw > Point > Measure ] 

 Select object to measure 

 Input length of  segments 

 Press enter(  )  on the keyboard 
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Special notes: 

 To see the points on the line create point style 

 Format > Point style > Choose point icon > ok 

 If total length is not a multiple of the length of segments then AutoCAD 

measures segments from the left side. Right most segment will be the remainder. 

 

5. Align (al) 

 Select objects 

 Press enter(  )  on the keyboard 

 Specify first source point 

 Specify first destination point 

 Specify second source point 

 Specify second destination point 

 Press enter(  )  on the keyboard 

 Scale objects based on alignment points? 

 Yes (distribute and scale objects within the destination points) 

 No ( only align objects without scaling) 

 

10'
2'-6"

First Source point Second Source point

First Destination

point

Second Destination

point20'
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Scale objects based on alignment points (Yes) 

 
Scale objects based on alignment points (No) 

 

 

 

 

 

 

20'

5'

First Destination

point

Second Destination

point

20'

2'-6"

First Destination

point

Second Destination

point
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6. Group (g) 

a. Create group 

 Type group name 

 Press “New” 

 Select desired objects 

 Press enter(  )  on the keyboard 

 Check “selectable” 

 Press ok 

 

b. Modify group 

 Select group name 

 Pick desired edit option (remove or add objects or explode)  

 Select desired objects 

 Press enter(  )  on the keyboard 

 Press ok 

 

7. Oops (oops) 

 Type “oops” in command bar 

 Press enter(  )  on the keyboard 

Special Notes: 

 This command restores the last deleted item only even you use other command 

in between. 

 Different from undo option because it (undo) only cancel last command. 

 

8. Wipeout (wipeout) 

 Type “wipeout” in the command bar  

 Draw any shape to clean hatch pattern 

 Press enter(  )  on the keyboard 

Important Control Keys 

 

Control Keys Result 

CTRL+8  Launches calculator window 

CTRL+A Select all 

CTRL+N Create new drawing 

CTRL+P Opens the plot dialogue box 

CTRL+S  Opens the save dialogue box 

CTRL+Z  Undo  the last operation 

CTRL+TAB  Switches between open drawings 

Esc Cancel command 
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Tips for Working Faster in AutoCAD 
 

Working faster is not simply beneficial for finishing exams by deadlines, but also very 

important to employers for whom efficiency and production speed are critical to business 

success.  

1. At first think about the drawing to indentify centerlines or a starting point. 

2. Try to develop a preference for using commands at the keyboard rather than selecting 

icons in toolbars or items in menus. It is much faster.  

3. Always look at the command line for guidance when you are learning new AutoCAD 

commands. The command line will prompt you for information and this is the easiest 

way to find out how a new command works. 

4. When a command is used, apply it as many times as you can before going on to 

something else.  

5. Press the “Enter” or “Space” button to activate last used command. 

6. Press the up-arrow and down-arrow keys to cycle through the stack of commands that 

you’ve used recently. 

7. Try to think ahead as you draw. This will enable you to do more things at the same 

time, and it will reduce down time needed for thinking before proceeding to the next 

task.  

8. To trim overlapping lines at corners, use the Fillet command with a “0” radius. If the 

fillet radius is set to round corners, remember that you can hold down on the Shift key 

to use Fillet as though the radius were set at "0" even though it is not. You will save 

the time required to reset the radius. 

9. Fillet two parallel lines to get an arc. 

10. To extend or trim try to select all as destination line or cutting edge by using Right 

click of mouse. Use Shift key to alter extend and trim command. 

11. Every command makes it faster to do something. Practice and remember such 

commands as Copy, Mirror, Stretch, and Array etc.  

12. Often Copy and Paste objects rather than recreating them. Even objects as simple as 

circles are often copied more quickly than drawing each one individually.  

13. Copy and Edit text, leader lines, and arrows rather than re-invoking the Text or 

Leader command and taking time to go through the basic options. Leader lines can 

very easily be adjusted by manipulating the grips.  

14. If a line or other object is drawn incorrectly, think first of correcting it by 

manipulating its grips. It is usually much faster than deleting it and redrawing it 

correctly. Don’t go slow for fear of making mistakes.  

15. Avoid switching back and forth between layers. Create everything on the layer that 

most objects will be on, and then at the end reassign objects to the correct layers. 

Reassign one object, and use Match Properties to reassign all other objects that should 

be on the same layer.  

16. Compete with yourself to increase drawing speed and efficiency.  

 

Courtesy: http://www2.hawaii.edu/~dmadden/acad%20tips.htm 
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Assignments 

 

1.  

 
Use Line, Rectangle, Circle 

2. 

 
Use Line, Arc / Polyline 

3. 

 
Use Line, Arc 

16' 6'

45°

45°

R3'

12'

10' 10'10'

45°

2'

2'
1'

1'

3'

10"

1"1.5"

1.5"

2.5"

2'-10"
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4. 

 
Use Rectangle , Line, Offset 

5. 

 
Use Copy(for donut) ,Hatch (Conc. ,Sand) 

1'-8" 1'-5" 1'-5" 1'-8"

4'3"

3"3" 3" 3"

3"

3"

3"

GL

4'

1'

3" 3"

3"3"

#5@ 5" C/C#6 @ 5" C/C
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6. 

 
 

 
Use Offset, Copy, Scale factor of Dimension Style 

Ground Floor

1st Floor

Roof

2nd Floor

3rd Floor

4th Floor

Base

6'

10'

10'

10'

10'

10'

18' 20' 18'

6'

4' 6"
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7. 

 
Use Center line 

12' 12'

12'

3'

12'

2'

2'-6"

7'-6"

4'

2'-6"

2'

4'4'

5"

5"
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8. 

 
Use Block 

12' 12'

12'

3'

12'
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9. 

 
Use Offset, Rectangular Array 

10. 

 
Use Offset, Polar Array 

1'

1'

1'

1'

1'-6" 1'-6" 1'-6" 1'-6"
R2"

Center

R3'
3"
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11. 

 
Use Offset, Polar Array 

12. 

 
Use Polar Array 

R3'
3"

Center
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13. 

 
Use Offset, Trim, Hatch (brick) 

14. 

 
Use Hatch (Conc.) 

10"

2.5"2.5"

6"

6"

6"

6"

3" 30"

3'

2"

1'-6"

6"

1"

5"
1"

1"
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15. 

 
Use Line, Arc, Offset, Hatch 

 

 

 

6'

5'

3'


